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Chapter 7: Horizontal and Vertical Design 
Introduction 

Since there are many different, and acceptable, methods of creating 
horizontal and vertical geometry using GEOPAK, this chapter will not 
dictate the exact methods to use.  Instead we will describe the different 
methods that can be used and provide a workflow for a macro that will 
check the horizontal alignment design for kinks, once completed.  This 
chapter will be in two sections: Horizontal Design and Vertical Design. 

Horizontal Design 

There are four methods of setting a horizontal alignment: Coordinate 
Geometry (COGO), Graphical COGO, Horizontal Alignment Generator, 
and Store Graphics.  Any of these methods are acceptable to CFLHD.  
Each one of these methods has their advantages and disadvantages, 
since graphical COGO and the horizontal alignment generator are 
similar, we will address these tools together.  This chapter will describe 
each of the above listed methods and indicate their advantages and 
disadvantages.  Regardless of the method used, the final 
alignment must be drawn into MicroStation using the GEOPAK 
D&C Manager, with the CFLHD .ddb file.  This will assure that the 
elements are drawn with the correct symbology, matching the CFLHD 
standards. 

Coordinate Geometry 
Coordinate Geometry can be accessed using Project Manager by 
selecting the Coordinate Geometry button. 

 
Figure 7-1:  Accessing COGO through Project Manager 
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You can also select the Coordinate Geometry button on the GEOPAK 
main dialog box. 

 
Figure 7-2:  Accessing COGO through Road Tools Icon 

If you are using Project Manager, Coordinate Geometry dialog box will 
be invoked.  Otherwise, the Job Number and Operator code will have 
to be entered in the COGO Startup dialog box.  Project Name and 
Subject are optional fields.  Press the OK button to bring up the 
Coordinate Geometry window. 

 
Figure 7-3: Coordinate Geometry 

You can create the horizontal geometry by typing commands in at the 
COGO command line, by creating an input file with a sequence of 
COGO commands and loading it into COGO, or by using the dialog 
box driven Store Curve from Tangents, Locate Traverse, etc., tools 
that are accessed from the COGO pull down menus to generate the 
commands.  If you use the input file method, remember that the COGO 
input file name can only be 8 characters long, must have the job 
number as the last three digits in the name, and the extension has to 
have an “i”+ the operator code.  (i.e. XXXXX101.ijd), where the i 
stands for input file. 

Advantages. 

• This method allows the user to have more precise control over 
tangent bearings, control point coordinates, etc., than with 
Store Graphics, if done properly. 

• The user can set visualization on to view progress of design. 
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Disadvantages. 

• Commands for the command line and input file methods are 
difficult to memorize. 

• Small adjustments are hard to make. 

• Process is time consuming. 

Uses. 

• Reviewing both horizontal and vertical alignments. 

• Creating output of alignments for printing. 

• Tweaking alignments that were created using store graphics, or 
any of the other methods. 

• Storing as-built centerline chain and profiles, especially those 
for which there are only hard copy paper plans. 

Graphical COGO 
Graphical COGO allow the user to create coordinate geometry 
elements using COGO tools with graphic and a user-friendly process.  
Graphical COGO can be accessed by selecting: 

Applications>GEOPAK ROAD>Geometry>Graphical 
Coordinate Geometry  

 
Figure 7-4:  Accessing Graphical COGO  

Or by selecting the icons from the main GEOPAK Road tool dialog 
box. 
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Figure 7-5:  Graphical COGO Icons 

The Graphical COGO tool frame shown below contains tools for 
creating COGO elements such as lines, points, curves, modifying 
COGO elements, manipulating elements, and grouping elements. 

 
Figure 7-6:  Graphical COGO Tool Frame 

From the main Graphical COGO tool frame, shown above, additional 
tools may be accessed from each of the four main tool boxes. 

 

 

 

 
Figure 7-7: Graphical COGO Tools 

 

 

 

 

The Graphical COGO tools shown above, and those 
in the Horizontal Alignment Generator, look and act 
the same as many MicroStation tools.  However, 
these tools are not relying on the accuracy of 
MicroStation graphics, but rather the much more 
accurate GEOPAK coordinate geometry engine. 
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Horizontal Alignment Generator (Element Based) 
Graphical COGO and the Horizontal Alignment Generator, allow the 
user to create coordinate geometry elements, much the same as the 
original COGO tools, but with a much more graphic and user-friendly 
process.   

The Horizontal Alignment Generator can be accessed through the 
Project Manager by clicking on the Horizontal Alignment button on the 
flow chart and selecting Graphical Element Based geometry.  
Horizontal Alignment Generator can also be accessed by selecting: 

Applications>GEOPAK ROAD>Geometry>Layout 
Alignments Horizontal 

Or by selecting third icon in the Horizontal & Vertical Geometry tool 
box.  Selecting this icon will invoke the Horizontal Alignment Generator 
Menu. 

 
Figure 7-8:  Horizontal Alignment Generator  

   

Figure 7-9:  Horizontal Alignment Generator Menu 

The File pull-down menu allows the user to set preferences for how 
newly created elements will be displayed, how to name elements, and 
which geometry tables to use as a default.   CFLHD uses the Spiral 
Design Tables.  To access the Spiral Design Tables, path should be 
set to V8_RESOURCE\X_30\Standards\Bin\english or metric. 
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Figure 7-10:  Horizontal Alignment Generator Preference 

The Design Tables menu allows the user to view the settings for the 
current default design tables.  In the Design Tables pulldown, the user 
sets the paths and file names for the tables to be accessed.  Currently 
CFLHD uses only the Spiral Curve tables (Metric and English).  Once 
the English or Metric Spiral Curve table is selected, select the design 
speed and number of lanes.  These tables correspond with the 
AASHTO Green Book.   

 

Figure 7-11:  Design Tables – Spiral Curve 

The tools menu activates the COGO tools that will be used to create 
geometry elements.  Selecting Tools>Main accesses the following 
tool frame. 
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Figure 7-12:  Horizontal Alignment Generator Tool Frame 

From the main tool frame, shown above, additional tools may be 
accessed from each of the six main toolbox icons. 

 
Figure 7-13:  Horizontal Alignment Generator Tools 

Each of the tool boxes shown above, as well as the tools from 
Graphical COGO, may be used together to create any combination of 
geometry, from the simplest to the most complex. 

Advantages 

• Using these tools to set a horizontal alignment, if done 
properly, is just as accurate as traditional command line 
COGO. 

• The user does not have to remember syntax of COGO 
commands.  

 

 



 

STANDARDS FOR USE WITH X30 CRITERIA 
7-8 

1/10/2013 

CFLHD CADD Standards Manual 
Chapter 7 — Horizontal and Vertical Design 

Disadvantages 

• The Graphical COGO and Horizontal Alignment Generator 
tools can be complicated. 

• The process is slower than using store graphics, as detailed 
below. 

Uses 

• When the geometry is known, as the input of As-Built 
alignments. 

• When the user wants to give exact bearings and distances. 

Store Graphics 
The store Graphics procedure is the simplest and quickest method to 
create a horizontal alignment.  The user can use standard MicroStation 
draw utilities to layout the alignment then use the Store Graphics tool 
to store the alignment into COGO.  Even though MicroStation 
measurements are to single precision, GEOPAK stored elements are 
computed to double precision accuracy.  Store Graphics will make 
slight adjustments to the graphical element locations as required 
forcing each element in the chain to be exactly connected to the 
immediately preceding element and the immediately following element.  
These adjustments are always minor (e.g. the coordinates of a curve’s 
PC and/or PT may be adjusted a few millimeters to force the curve to 
match the tangents exactly) but they do occur and the user has no 
control over them.  However, if the graphical elements were drawn 
correctly then the chain that gets stored into the gpk file is exactly as 
“accurate” as a chain stored using any of the other methods. 

TIP:  Use the filet tool to construct the final curves in the alignment. 
Placing an arc by tangential snap does not always give accurate 
results. 

This command cannot be accessed using Project Manager, but can be 
accessed the following two ways.  From the GEOPAK pull down 
menus select, Applications>GEOPAK ROAD>Geometry>Store 
Graphics 
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Figure 7-14:  Accessing Store Graphics 

Or by selecting the icons from the Geopak Road tool box as shown 
below: 

 
Figure 7-15:  Store Graphics Icon 

Selecting the Store Graphics Icon will invoke the Store Graphics 
Dialog box.  Points, curves, chains and parcels can be stored with this 
dialog box. To store a horizontal alignment, toggle to Chain as shown 
below. Set the Mode to Complex Chain.  Enter the Job number (use 
the magnifying glass to browse to the GPK file), the Operator Code 
(users first and last initial), the name of the chain that will be stored 
and the Beginning Station of the horizontal alignment. 
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Figure 7-16:  Store Graphics 

The Beginning Point of the chain must be a unique point that has not 
been used previously.  To check what points have already been used 
in the project, go to Coordinate Geometry (COGO) Dialog box as 
shown below.  Select Element from the top of the COGO Dialog box. 
Go to Point and then Utility. This opens the Point Utility Dialog box 
which lists all of the points that have been used already.  Points can 
contain numbers and letters. After determining an unused point, close 
the COGO Dialog box (Choose No when the ‘COGO session not 
saved’ Alert appears).  

  

Figure 7-17:  Unique Beginning Point 
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Enter a unique Beginning Point in the Store Graphics Dialog box.  Fit 
the entire horizontal alignment in a View (if a portion of the alignment is 
not in the view, it will not be stored).  Click on the ID Element button.   

 

Figure 7-18:  ID Element 

In the view with the entire alignment, data point the first element in the 
horizontal alignment, the element will then appear highlighted.  Click 
again, and the rest of the elements will be highlighted.  Click again to 
accept the chain, and the Store button will become un-ghosted. Click 
the Store button. Click OK on the Store Graphics Notification. 

 

Figure 7-19:  Store Chain 
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Advantages 

• Use simple MicroStation commands to layout alignment, 
adjustments to alignment are quick, and the only point numbers 
used are on the alignment (usually just the first and last). 

Disadvantages 

• Not as accurate as COGO.  Store Graphics makes minor 
adjustments to the as-drawn elements in order to get them to 
tie together mathematically. 

• Cannot draw spirals using MicroStation commands.  If spirals 
are needed, you must use Horizontal Alignment Generator to 
create that element, and then you may continue using 
MicroStation commands.  

Uses 

• For general and normal chain creations. 
 
• For long alignments with many elements.   



 

STANDARDS FOR USE WITH X30 CRITERIA 
7-13 

1/10/2013 

CFLHD CADD Standards Manual 
Chapter 7 — Horizontal and Vertical Design 

Coordinate Geometry (COGO) Tools – Geopak 2004 
In GEOPAK 2004 there have been few enhancements to the workings 
of the existing coordinate geometry tools.  The main COGO dialog box 
has been enhanced to include utilities for each type of COGO element 
such as points, lines, curves, chains, etc.  The utility dialog box will 
allow the user to functions such as visualize, print, transpose, etc., for 
each element type.  This allows the user to more efficiently work with 
each type of element independently.  The new COGO dialog box, 
along with some of the utility dialog boxes is shown below. 

 

 

Figure 7-20: New COGO Tools 
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Vertical Design 

There are two methods available for creating and storing an Existing 
Ground profile; Traditional method and the new Draw Profile Tool 
method. 

Traditional Existing Ground Profile Tool 
Once a run is created for the working alignment, the existing ground 
profile should be created and then drawn using the D & C Manager.  
CFLHD’s traditional method for cutting existing ground profile is shown 
below.  Existing Ground Profile can be accessed through the Project 
Manager by selecting the Existing Ground Profile button. 

 

Figure 7-21:  Accessing Existing Ground Profile through Project 
Manager 

The Existing Ground Profile dialog can also be accessed by typing in 
mdl load ex_prof command in the MicroStation Key-in box. 

 

Figure 7-22:  MicroStation Key-in 

The following Existing Ground Profile dialog box will appear. 
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Figure 7-23:  Traditional Existing Ground Profile  

Enter in the required information and select Apply.  Apply will cut your 
existing ground profile for the chain and store it into the GPK file.  
Existing ground profile can be accessed and drawn into MicroStation 
using the Geopak D & C Manager, with the CFLHD .ddb file.  This will 
assure that the existing ground profile is placed with the correct 
symbology. 

Draw Profile Tool - GEOPAK 2004 
New to GEOPAK 2004 is a streamlined way to create existing ground 
profiles, and plot both existing and proposed profiles.  The Draw 
Profiles tool is not available through project manager workflow dialog 
box, but can be accessed by selecting Applications>GEOPAK 
ROAD>Plans Preparation>Draw Profiles 



 

STANDARDS FOR USE WITH X30 CRITERIA 
7-16 

1/10/2013 

CFLHD CADD Standards Manual 
Chapter 7 — Horizontal and Vertical Design 

 
 

Figure 7-24: Select Draw Profiles 

 

The Draw Profiles tool may also be accessed from the Plans 
Preparation tool palette as shown below. 

 
Figure 7-25: Draw Profile Icon 

 

All that is needed for this tool is a horizontal alignment and a .tin file.  
This tool allows for the creation of an existing ground profile in much 
the same way as the Traditional method, but does so behind the 
scenes, with increased efficiency and a much cleaner workflow.  This 
tool also allows the user to draw profiles into MicroStation using the 
D&C Manager .ddb settings ensuring adherence to the CADD 
standards.  Also, with the Draw Profiles tool, there is no need to delete 
before re-drawing updated profiles. 
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Workflow 1:  Creating an existing ground profile using 
Draw Profiles Tool 
To access this workflow, follow this link: 

http://www.cflhd.gov/resources/CADD/documents/Workflow_7.1_HVD
esignCreatingexistinggroundprofileswithDrawProfilesTool_x30.pdf  
 

 
 
 
 
 
 

 

 

   Figure 7-39: Profile Drawn into MicroStation 

The projection tab can be used when the chain and profile that needs 
to be drawn is different than the chain and profile used to create the 
profile cell. 

One advantage of using the draw profile tool is the 
Update application.  With this, it is possible to 
update all profiles and the Label Scale with one 
click.  The user does not need to delete and redraw 
elements. 

http://www.cflhd.gov/resources/CADD/documents/Workflow_7.1_HVDesignCreatingexistinggroundprofileswithDrawProfilesTool_x30.pdf
http://www.cflhd.gov/resources/CADD/documents/Workflow_7.1_HVDesignCreatingexistinggroundprofileswithDrawProfilesTool_x30.pdf
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           Figure 7-40: Profile Projection Tab 

Proposed Vertical Alignment 
There are two tools used to set proposed vertical alignments, and both 
are acceptable to CFLHD.  Engineers and designers have used the 
VPI based Vertical Alignment Generator since the early days of 
GEOPAK.  This tool, although having been around for years is still a 
user-friendly, accurate method for creating and storing vertical 
alignments.  The second method is the Component Based Vertical 
Alignment Generator.  This tool has been updated and improved over 
the VPI based tool, and has yet to be fully utilized by most GEOPAK 
users.  Both these methods are just as accurate and depending on 
your preference, as easy to use.     

VPI based Vertical Alignment Generator 
The VPI based Vertical Alignment Generator is the traditional method 
used by CFL designers in creating vertical alignments.  Vertical 
alignment generator can be accessed through Project Manager by 
selecting the Vertical Alignment button. 
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Figure 7-41: Accessing Vertical Alignment through Project Manager 

The VPI Based Vertical Alignment Design Tool may also be accessed 
from the Horizontal & Vertical Geometry tool palette as shown below. 

 
Figure 7-42: VPI Based Vertical Alignment Icon 

Selecting the VPI Based Vertical Alignment Design Tool will invoke the 
dialog box below: 
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Figure 7-43: VPI Based Vertical Alignment Settings 

Once the settings are defined, selecting OK will invoke the GEOPAK 
Profile Generator.   

 

Figure 7-44: Profile Generator 

For US Customary projects, the User Preferences are as shown 
below:   

 
   Figure 7-45: User Preferences 
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If the project requires the use of Maintaining K value instead of 
Maintain VC Length, commonly used, attach the correct K-Value table.  
K Value Table can be accessed by selecting User>K-Values. The 
following dialog will appear: 

 

Figure 7-46: K-Value Table 

Use File>Open to attach the correct unit K-Value table (.kvl).  K-Value 
table can be attached from V8_RESOURCE\X_30\Standards\Bin\ 
english or metric. 

After the proposed vertical alignment is created and saved, use the 
Draw Profile Tool or the D&C Manager to drawn profile in MicroStation, 
ensuring adherence to the CADD standards.  For CFLHD projects, the 
toggles shown below must be selected prior to drawing the profile. 

    

Figure 7-47: D & C Manager to Draw Profile Draw 
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Component Based Vertical Alignment Design Tool 
The new method to create vertical alignment introduced with     
Geopak 2000 is the Component Based Vertical Alignment Design 
Tool.  This method allows for vertical alignment to be created 
graphically and stored using Store Graphics command, similar to the 
horizontal alignment Store Graphics command.  The Component 
Based Vertical Alignment Design Tool requires COGO to be active as 
well as an Active Chain and Active Profile Cell.  Component Based 
Vertical Alignment Design Tool requires the use of Active Chain 
Control, a method introduced with Geopak 2000.  Active Chain Control 
can be used in place of the 3 port viewer.  

 

Workflow 2:  Creating Proposed Vertical alignment 
using Component Based Vertical Alignment Design 
Tool 
To access this workflow, follow this link: 

http://www.cflhd.gov/resources/CADD/documents/Workflow_7.2_HVD
esignCreatingProposedProfilesusingComponentBasedVerticalAlignme
ntDesignTool_x30.pdf 
 
The various methods for creating horizontal and vertical geometry 
using GEOPAK are describe in this chapter.  Regardless of the 
method used, the final alignment and profile must be drawn into 
MicroStation using the GEOPAK D&C Manager, with the CFLHD .ddb 
file.  Workflow 3 outlines a macro used at CFLHD to check the 
horizontal alignment design for kinks. 

 

Workflow 3:  Macro - Checking for Kinks in Horizontal 
Alignment 
To access this workflow, follow this link: 

http://www.cflhd.gov/resources/CADD/documents/Workflow_7.3_HVD
esignMacroforCheckingforKinksinChains_x30.pdf  

 
 
 

http://www.cflhd.gov/resources/CADD/documents/Workflow_7.2_HVDesignCreatingProposedProfilesusingComponentBasedVerticalAlignmentDesignTool_x30.pdf
http://www.cflhd.gov/resources/CADD/documents/Workflow_7.2_HVDesignCreatingProposedProfilesusingComponentBasedVerticalAlignmentDesignTool_x30.pdf
http://www.cflhd.gov/resources/CADD/documents/Workflow_7.2_HVDesignCreatingProposedProfilesusingComponentBasedVerticalAlignmentDesignTool_x30.pdf
http://www.cflhd.gov/resources/CADD/documents/Workflow_7.3_HVDesignMacroforCheckingforKinksinChains_x30.pdf
http://www.cflhd.gov/resources/CADD/documents/Workflow_7.3_HVDesignMacroforCheckingforKinksinChains_x30.pdf
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